DATACAD LLC
Software for AEC Professionals
TECHNICAL BULLETIN

Using Layer Manager in DataCAD 10
The Layer Manager gives you control over each layer’s number, status (on, off, locked, and unlocked), color, and name.
It displays the number of entities on each layer in the Count column.
The Layer Manager allows you to assign meaningful names (up to 88 characters long) to each layer; however, these
names are truncated to the first eight characters in the ViewLyr list. When you move your cursor over a truncated layer
name in the ViewLyr list, the tooltip displays its full name. (You can control the appearance and duration of tooltips by
using the Tools pull-down menu, selecting Program Preferences, and changing the Tooltips options to suit your needs.)

Accessing Layer Manager
To open the Layer Manager, use one of these options:
•

Select Layers from the Utility menu, choose Layer, and click on Manage in the Layer menu.

The Layer Manager dialog box appears.
•

Or select Layer Manager from the Tools pull-down menu.

The Layer Manager dialog box appears.
•

Or use the keyboard shortcut [L] for Layer and [S8] for Manage.

The Layer Manager dialog box appears.
•
•

Or click on the active layer’s name in the status window.
Or use [Ctrl] + [L].

The Layer Manager dialog box covers the majority of your drawing window. But you may want to perform some
functions (such as color matching) where it is important that you see both the drawing and the layer options by using the
traditional left-hand Layers menus and submenus. The quickest way to access these layer functions is by pressing [L].
You may move the Layer Manager dialog box away from the middle of your screen. Just click on the title bar and hold
your left mouse button down while you drag the dialog box to another position on your screen.
The Layer Manager dialog box can display about 17 layers at a time. If your drawing has more layers, you can stretch the
dialog box by pulling on its corners or sides. You can also maximize the Layer Manager so that it covers your entire
screen by clicking on the Maximize icon or double-clicking on the title bar or the dialog box. Depending on your
monitor’s resolution, you may see as many as 50 layers at a time when you maximize the Layer Manager dialog box.
If your drawing has so many layers that you cannot see them all on the list in your Layer Manager dialog box, a scroll bar
appears at the right side of the layer list. To see more layers, you can use the scroll bar arrows, [PageUp], [PageDown],
[Up Arrow], [Down Arrow], [Home], [End], or the mouse wheel.
The layer list box has columns that are labeled LayerNum, On, Lock, Name, and Count. You can make the LayerNum or
the Name columns wider or narrower by clicking on the space between adjacent column headings. When your cursor
changes shape (from an open arrow to a vertical line with arrows facing left and right on either side), you can drag it left
or right to expand or decrease the column’s width. To make each column as narrow as possible, double click on the space
between adjacent headings. Actually, the only column that needs to be wide is Name.
Initially, the only active buttons are AllOn, New, Ok, and Cancel. When you highlight the layer you want to work with,
other buttons will become active.

Changing a Layer’s Position in the List
Each layer has a number. You can change a layer’s position in the list to meet your current needs. For example, you may
want all the locked layers at the top of your list.

To change a layer’s number or position in the list:
1. Click on the number of the layer you want to change.

The layer you selected is highlighted in the Layer Manager dialog box. Notice that in addition to AllOn and New, the
SetActive, ActiveOnly, Erase, Delete, MoveUp, and MoveDn buttons are active.
Hint: To select several successive layers (for example, layers 3 through 6) click on the first one, press down and hold
[Shift], and click on the last layer. Release the [Shift] key when you have highlighted the successive layers you want to
work with in the Layer Manager dialog box.
To select several layers that are not in consecutive order (for example, layers 3, 5, and 7), you select the first one,
press down and hold [Ctrl], and click on the other layers. Release the [Ctrl] key when you have highlighted the
nonconsecutive layers you want to work with in the Layer Manager dialog box.
2. Click on the MoveUp or MoveDn button until you are satisfied with the layer’s new position.

Alternatively, you can use the mouse to reposition the layer with drag and drop. Just click on the number, drag your
mouse, and release the left mouse button when you reach the desired new number to dynamically reposition the layer.
Hint: When you make changes to the position of the layers by using the MoveUp or MoveDn buttons or the drag-anddrop method, DataCAD automatically inserts a checkmark in the Save new layer order box. If this box does not
contain a checkmark, your changes will not be saved and the layers will return to their original positions when you
leave the Layer Manager dialog.
3. Click on the Apply or Ok button when you finish rearranging the layers.

This saves your layers in the new arrangement and deactivates the Revert button. When you click the Ok button, the
Layer Manager dialog box disappears and you return to the drawing window.

To return the layers you moved to their original positions, use one of these options:
•

Click on the Revert button if this option is available.

If you selected Apply, the Revert button will not be active. If you selected Ok, the Layer Manager dialog box will not
be displayed on your screen.
•
•

Or click on the Undo arrow once if the Layer Manager dialog box is not on your screen to return to the
positions that were last active.
Or press [Ctrl]+[Z] for Undo if the Layer Manager dialog box is not on your screen.

Sorting the Layers
Use Layer Manager to sort your drawing’s layers by clicking on the column titles. Clicking the same column title twice
will reverse the sorting order. For example, you may want to sort the layers alphabetically A-Z by the information in the
Name column. If you click the Name column a second time, the layers will appear alphabetically Z-A.
Hint: Sorting your layers by clicking on the column titles does not automatically place a checkmark in the Save new layer
order box. If you want to save the layers in the newly sorted order, make sure you click in the Save new layer order box so
that a checkmark appears before you exit from the Layer Manager dialog box.
If you just want to quickly check the on/off or lock/unlock status of the layers, you may not want to store the layers in that
order. In these cases, you probably wouldn’t want to put a checkmark in the Save new layer order box. Leaving the box
unchecked means that DataCAD will return the layers to the order they were in when you last opened the Layer Manager
dialog box.

This is what happens when you use the column titles to sort your layers:
•
•

LayerNum: Layers are arranged in numerical order. Clicking LayerNum again reverses the layers.
On: Layers that are On will appear first. Clicking On again makes the Off layers appear first.
Hint: You can use this with GoToView. Open a view first, then start Layer Manager, and sort by On/Off status. You
can also create a new GoToView from an existing one by changing the On/Off status of various layers.

•
•
•

Lock: Layers that are locked will appear first. Clicking Lock again makes the unlocked layers appear first.
Color: Layers will be sorted from white through the darkest shades. Clicking Color again will sort layers from
darkest shades to white.
Name: Layers will be sorted alphabetically from A to Z. Clicking Name again will sort layers from Z to A.
Hint: Pressing a letter will take you to the first layer in the list that begins with that letter.

•

Count: Layers will be sorted numerically from the smallest to the largest number. Clicking Count again will sort
layers from the largest to the smallest numbers.

Hint: Count indicates the number of entities contained on a particular layer. You can sort by count to quickly find the
layers that do not contain any drawing entities. This makes it easy for you to delete empty layers from your file.

No matter how much you sort your layers in the dialog box, none of your GoToView or multiscale plots will be affected.

Changing Layer Settings
Each layer has different settings that you can change. These settings are on/off, lock/unlock, color, and name.

On/Off
A solid yellow light bulb in the On column indicates that a layer is on; a clear bulb means that a layer is off. The green
bulb designates the active layer. Only one bulb in the layer list can be green (meaning that layer is on and active);
however, any number of bulbs may be yellow (on) or clear (off).
To change the on/off setting for one layer:
1. Click on the light bulb of the layer you want to change.

If the bulb was originally yellow, it changes to clear and vice versa.
2. Click on Apply if you want to make other changes in the Layer Manager or click Ok to return to the drawing
window, where your change is in effect.

To change the on/off setting for several layers:
1. Highlight the layers you want to change by using [Shift] for successive or [Ctrl] for nonconsecutive layers.
2. Click on the light bulb for one of the highlighted layers.

All the bulbs in the highlighted layers are changed to the same setting.
Hint: This is true even if some of the bulbs in the layers you selected were on and others were off. For example, if you
highlighted layers 3 (on), 5 (off), and 6 (on) before you clicked on the bulb in layer 3, DataCAD would switch all three
bulbs off.
3. Click on Apply if you want to make other changes in the Layer Manager or click Ok to return to the drawing
window, where all your changes are in effect.

To turn all the layers on:
1. Click the AllOn button.
2. Click on Apply if you want to make other changes in the Layer Manager or click Ok to return to the drawing
window, where all the layers are on.

To designate the active layer:
1. Select the layer you want to change to active status.
2. Click on the SetActive button.

The bulb for the highlighted layer changes to green and its name is underlined. The bulb for the layer that was
previously active changes to yellow (on) and its name is no longer underlined.
3. Click on Apply if you want to make other changes in the Layer Manager or click Ok to return to the drawing
window.

Notice that the layer you selected is active in the status box in your drawing window.
To display only the layer you designate as active:
1. Highlight the layer you want to designate as active.
2. Click the ActiveOnly button.

The highlighted layer’s bulb is green (indicating it is on and active); all other bulbs are clear (off). The layer’s name
is also underlined.
3. Click on Apply if you want to make other changes in the Layer Manager or click Ok to return to the drawing
window.

Notice that the active layer is the only one that appears in the drawing window.

Lock/Unlock
You can edit unlocked layers, which are designated by an open padlock. Locked layers (closed padlock) are protected and
cannot be edited. Changing the Lock status of one or more layers is similar to changing the On status.
To lock or unlock one layer:
1. Click on the padlock you want to change.

DataCAD changes that layer’s lock status accordingly.
2. Make changes to other layers in the Layer Manager if necessary.

Remember that if you locked a layer, DataCAD will not allow you to make any changes to it.
3. Click Ok to return to the drawing window.

To lock or unlock several layers simultaneously:
1. Highlight successive layers by using [Shift] or several nonconsecutive layers by using [Ctrl] to select the
padlocks you want to change.
2. Click on a padlock in one of the selected layers.

If the padlock you clicked was originally unlocked, DataCAD will lock it and all the others in the layers you selected
in step 1.
3. Click Ok to return to the drawing window.

Color
In the Layer Manager, the color of each layer appears in a square swatch. Changing the color that applies to entities on a
layer is easy. Keep in mind that the color change will apply only to the new entities you create on that layer; the new
color doesn’t affect the entities that were on the layer.
For more information on the Color Palette and Color Picker functions, refer to the technical bulletin titled “Working with
Color in DataCAD 10.”
To change the color of a layer:
1. Click on the square swatch in the Layer Manager for the layer you want to change.

The Color Palette dialog box appears.

2. Select a new color from the sample swatches in the palette.
3. Click OK.

Notice that the new color you selected appears on the swatch in the Layer Manager.
If you do not like some of the available colors, you can easily mix your own.
Caution: Make sure that the color you want to change is unique among the layers in your drawing. If several layers use
the same color, change the selected layer’s color as shown in the previous steps so that it is different from the others. If
the color of the layer you want to change is not unique, all other layers sharing that color will also be changed in the editing
process.

To mix your own color for a layer:
1. Make sure the color you want to customize is unique and is not used by any of the other layers.

If necessary, follow the previous steps to change the color.
2. Click on the unique color swatch in the Layer Manager list.

The Color Palette appears.
3. Click on Edit to open the Color Picker dialog box.
4. Use your mouse in the RGB (red, green, blue) and/or HSB (hue, saturation, brightness) window to find the
color you prefer.

Since the layer’s original and new colors appear at the bottom of the Color Picker dialog box, it is easy to compare
the two.

5. Select OK when you are satisfied with the new color.

The Color Palette reappears with your new color in the swatch.
6. Click OK to exit the Color Palette dialog box and return to the Layer Manager.

Notice that the new color appears in the highlighted layer’s swatch.

Name
DataCAD allows you to use up to 88 characters (including spaces and numbers) for meaningful layer names. You can
change a layer’s name in several ways with the Layer Manager. When you click on a layer’s name once, that layer is
highlighted or selected; however, you cannot edit the name.
To change a layer’s name use one of these methods:
•

Double-click on the layer name you want to change, type the new name (up to 88 characters long), and press
[Enter].

The new name appears on the list in the Layer Manager.

•
•

Press [Enter] when a layer is highlighted, type the new name, and press [Enter].
Press [F2] when a layer is highlighted, type the new name, and press [Enter].

The longer layer names will be truncated to the first eight characters in the status box, in regular layer menu options, and
when you send your drawing file to somebody who is using an earlier version of DataCAD. For this reason, you should
try to make the first eight characters of each layer name unique.

Using Other Layer Functions
With the Layer Manager, you can add new layers, erase all the entities on a layer, delete a layer, or revert to previous
layer settings. To access these basic functions, you use the buttons on the right side of the layer list.

Add New Layer
The Layer Manager makes it easy to add new layers to your drawing. While you add the layer, you also set its name,
on/off and lock/unlock status, and color. Initially, the new layer will not contain any drawing entities; those accumulate in
the Count column as you use the layer.
To add a new layer to your drawing file:
1. Highlight the layer that should appear before or above the new one you are creating.

DataCAD adds the new layer after the highlighted one. For example, if you want the new Brick layer to come before
Stucco, you would highlight Metal.

Hint: You can add a new layer at the end of the list by clicking on the last layer.
2. Press [Insert] or click on the New button to the right of the layer list.

The Create New Layer(s) dialog box appears and you are prompted to “Enter the number of new layers to create.”

3. Input the number of layers you want to add to your drawing and press [Enter] or click [Ok].

The new layer appears above the one you initially highlighted.

Hint: DataCAD allows you to have up to 1,000 layers per drawing file. For most projects, this should be more than
adequate. The Layer Manager keeps track of how many layers you can add until you reach the 1,000-layer limit;
therefore, the number before the final hyphen changes to reflect this running total.
4. Type a name for the new layer and press [Enter].

Notice that Count contains a zero because there are no entities in this layer yet. Also notice that the new layer inherits
the same On/Off, Lock/Unlock, and Color characteristics as the preceding original layer since that served as a
“parent.”

5. Continue adding new layers by repeating steps 1 through 4.
6. Click in the box at the bottom of the Layer Manager to put a checkmark.

This indicates that you want DataCAD to save the new layer order. When you are finished adding new layers to your
drawing file, click on Apply (if you want to continue working in the Layer Manager) or Ok (if you do want to leave
the Layer Manager and return to your drawing window now).

Erase Entities from a Layer
You can quickly eliminate all the entities on a layer. This can help you save time when you want to make major changes
on a particular layer of your drawing.
To erase entities from a layer:
1. Highlight the layer that contains the entities you want to eliminate.
2. Click on the Erase button to the right of the layer list.

A Warning box appears.

3. Click on the Yes button or press [Enter].

DataCAD puts an eraser in the Count column to signify that you are eliminating all of the entities on that particular
layer.
Hint: The entities will be erased from your drawing when you click Apply or Ok (to exit the Layer Manager dialog box),
but DataCAD gives you a chance to change your mind and keep those entities. To change your mind, simply select
either the Revert or Cancel.
If you sort by Count at this point, all the layers that contain the eraser icon will appear at the top of the list.

4. Click on Apply if you want to have the entities erased while you continue working in the Layer Manager.

Click Ok if you want to have the entities erased and return to your drawing window. DataCAD erases the entities on
the layer.

Delete a Layer
You can eliminate an entire layer from your drawing. It doesn’t matter whether the layer contains hundreds of entities or
none.
To delete a layer:
1. Highlight the layer you want to eliminate from your drawing file.
2. Press [Delete] or click on the Delete button to the right of the layer list.

A warning box appears, giving you a chance to change your mind.

3. Select Yes or press [Enter] to indicate that you want to continue.

The layer disappears from the list.
Oh No! What if you accidentally deleted the wrong layer? Don’t panic because DataCAD gives you three more
chances to change your mind. You can click Revert to restore the layer immediately; the other alternatives are to
select Cancel or use the Undo function.

When you delete a layer, your GoToViews and Multiscale Plots may be affected if you also eliminated critical entities in
the process. Of course, those eliminated entities would not appear; however, the views and plots would not crash.

Changing an Incorrect Layer Setting
There are three ways for you to change settings if you made a mistake in the Layer Manager dialog box. Depending on
when you notice the mistake, you can select Revert or Cancel or use the Undo button if you don’t catch the error until
you leave the Layer Manager dialog box.

Revert to Previous Settings in the Layer Manager
If you accidentally do something to a layer (such as eliminate all its entities, turn a layer off, or eliminate the layer
entirely), you can go back to the previous settings with Revert. Remember that Revert cannot go back beyond the last
time you clicked on Apply.
Revert is available after you do something on the Layer Manager’s list and only applies to what you just did. For
example, if you change a layer’s status to Off and then give the layer a new name, Revert will give you a chance to return
to the older name, but it will not turn the status to On. If Revert is unavailable (the button is gray), it’s too late to change
your mind about a previous decision.

Cancel or [Esc]
If Revert is not available (the button is gray) or you notice a previous error (such as eliminating all the entities in the
wrong layer) you made during the current Layer Manager session, you can use the Cancel button or press [Esc]. Selecting
Cancel or pressing [Esc] closes the Layer Manager and puts you back in the drawing window, ignores all the changes you
made since you last selected Apply, and returns all layer settings to those that existed previously in your drawing file.
You can’t selectively eliminate some changes and retain others. If selecting Cancel eliminated settings that you wanted to
keep, you must reopen the Layer Manager dialog box, make the changes again, and save them when you exit the dialog
by choosing the Ok button.

Undo
Use the Undo arrow on your button bar or select Undo Layer Manager from the Edit pull-down menu if the Layer
Manager dialog box is not active on your screen. This eliminates all the things you changed the last time you used the
Layer Manager dialog box. If you restored your old layer settings with Undo but want to keep them after all, just click on
the Redo button or select Redo Layer Manager from the Edit pull-down menu.

Exiting from the Layer Manager
The buttons on the bottom of the Layer Manager dialog box give you several exit options:

•
•
•
•

Apply. When you click on this button, the changes you make in the layer list take effect in your drawing while the
Layer Manager dialog box remains open.
Save new layer order. This check box is available if any of your changes involved the original layer order or if you
added or deleted layers. By default, when this box is initially active, it contains a checkmark. Remember to uncheck
this box if you want to go back to the layer order that was in effect before you opened the Layer Manager.
Cancel. This disregards everything you did since opening the Layer Manager dialog box. Clicking this button returns
you to the drawing window and retains your layer settings to those that were in effect before you opened the Layer
Manager.
Ok . Clicking this button returns you to your drawing screen and makes all the layer setting changes take effect in
your drawing file.

Hint: if you press [Esc], this has the same effect as selecting Cancel. You will exit from the Layer Manager dialog box, but
none of the changes you made will be saved.

